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Have you ever browsed the charts and indictors of web sites like Yahoo! Finance 
and wondered which technical indictor would be the most lucrative? Do you wish 
there were some way to distinguish the superstition from the science in technical 
analysis? Have you ever wondered how much you would have made or lost over the 
past year had you adopted a certain trading strategy? If you answered 'yes' to any 
or all of these questions, read further. 
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Introducing Trade Strategist

What is Technical Analysis?
Technical Analysis is a field of finance in which trading decisions are 

based on measurable quantities, rather than the psychology of the 

trader. A 'technical' trader makes use of charts and indicators that derive 

from price and other data to decide when to buy or sell stock.

Technical analysis is also popular with amateur traders, as witnessed by 

the success of web sites like Yahoo! Finance. These sites include charts 

and indicators, in addition to data like price and volume. But how do you 

decide which indicators are most profitable? And how should you 

combine the available indicators into an effective trading strategy? 

What is Trade Strategist?
Trade Strategist is a tool designed to help you develop an effective 

trading strategy by utilizing the various indicators of Technical Analysis. 

A common problem faced by amateur traders is a lack of faith in their 

adopted trading approach. If you have traded yourself, you probably 

know the feeling: you see your stock plummeting in price, and even 

though you reason that it will rebound, you end up selling the bottom and 

swallowing a big loss. Your trading is being governed by your 

psychology, rather than by a rational, well-tested, and most-importantly, 

mechanical strategy.

What if you could see how effective a trading strategy was by testing it 

on historical data, before you begin to use it? That's what Trade 

Strategist is all about. You combine the indicators you find on financial 

web sites into formulas which trigger buy and sell signals. Trade 

Strategist takes your 'strategy', downloads historical data from the web 

for the stocks you would like to test, and runs through the data making 

virtual trades based on your strategy. Within a few seconds you can see 

how much you would have made or lost had you adopted the strategy. If 

it works well, you try it on other stocks; if it doesn't, you discard or 

improve it. It's a bit like paper trading at high speed!
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Concepts in Trade Strategist

Simulation
Trade Strategist is designed to carry out trading simulations. It processes 

downloaded stock data, acting on signals from a trading strategy to buy 

or sell stock, as if it were really trading in the stock on the stockmarket. If 

on a given date, the trading strategy triggers a buy signal, trade strategist 

performs the calculations to determine how much stock could be bought 

with the money available, and updates a virtual account, as if the trade 

were actually made. It then moves onto the next date, and repeats the 

process. At the end of the time period, it calculates how much the 

account is worth, and displays the results. 

This whole process is known as a simulation. A simulation is always for a 

single stock and a single strategy, over a given period of time. You can 

perform multiple simulations at once in Trade Strategist, for many stocks 

and/or strategies. 

Time Line
Time plays an important role in Trade Strategist, and as a user, it is 

important that you understand how it is treated. Trade Strategist works 

with daily data. Before you perform a simulation, you enter the range of 

dates for which it will be performed. The simulator them moves through 

this range one day at a time, determining whether a trade should be 

made each day, and making the trade if necessary. 

When defining strategies in Trade Strategist, a relative time scale is 

used. You can think of this in terms of a time line: The day the simulator 

is analysing to determine if a trade should be made is taken to be day 0. 

Price data is only available up to and including day -1. Day 1 is the day 

after the day being considered for a trade, i.e., it is in the future. The best 

way to think about it is to pretend you are deciding whether to make a 

trade after the close of trading on day -1. You have data up to and 

including day -1, but don't know the prices for the next day, day 0. You 

have to decide based on the data you already have whether to make a 

trade or not on day 0. This is exactly what a strategy does: it decides 

based on data up to day -1 whether to trigger a buy or sell signal on day 

0. 

Strategy
By now you probably have a reasonable idea what a strategy is. A 

strategy is effectively a formula which takes as input, data for a single 



stock, up to and including day -1, and can generate a buy or sell signal 

for day 0. It does not indicate how much stock should be bought or sold, 

but if a signal is generated, it does indicate the type of order that should 

be made (e.g. market order, limit order, etc.). 

Signal Rule
A strategy includes zero or more signal rules. A signal rule is an 

expression which when true, generates a signal. Three types of signals 

are possible: buy, sell, and hold. A buy indicates an order to buy stock 

should be made for day 0, though whether or not the trade is actually 

made will depend on the type of order, and the price data for day 0. For 

example, if a signal for a limit order to buy is generated, whether the 

trade is actually made will depend on whether the price on day 0 drops 

below the limit order price. A sell signal obviously indicates an order to 

sell stock. A hold indicates that no order should be made on day 0. 

Signal rules are evaluated in the order they are entered in the strategy. A 

trade order is generated for day 0 by the first signal rule encountered that 

evaluates true for a given date. If no rule evaluates true, a hold signal is 

generated. Signal rules can be reordered. 

Order Type
Order types in Trade Strategist basically correspond to the types of 

orders that can be placed on the stock market. The options are market, 

limit, and stop. Each order type is available for buying and selling stock. 

For example, if you create a sell signal rule, and set the order type to 

stop, you are actually creating what is commonly called a 'stop loss' 

order. 

If you are not familiar with these order types, it is recommended that you 

read more about them in a book about stock trading, as we don't have 

the space here to describe how the stock market works in any detail. 

A market order will always result in a trade in Trade Strategist. The price 

of a market order depends on the time at which the order is placed. In 

Trade Strategist you have a choice between having the market order 

placed at the open of trading, or the close of trading (on day 0, of 

course). Other times are not allowed, because Trade Strategist does not 

have access to price data at specific times other than for the open and 

close of trading. 

Stop and limit orders are different, because they are triggered when the 



price crosses a given value. In real life, these orders are placed at an 

absolute price. For example, we could make a limit order to buy stock at 

$3.45. If the stock price dropped below $3.45, our trade would go 

through. However, in a simulation, it may not make much sense to set an 

absolute price value for an order, because the price of the order will 

usually depend on the day it is being made. Trade Strategist allows you 

to set the price of stop and limit orders in relation to other prices, such as 

the previous day's close price, or to create custom expressions to 

calculate a price from the data available. For example, instead of setting 

a limit order at $3.45, in a strategy we could create an expression that 

sets the price to 1% less than the previous day's low price. 

Expression
In order to construct signal rules, you need a mathematical language for 

defining when a signal should be generated. You need a means of 

expressing what conditions need to be met for a particular signal to be 

generated. In Trade Strategist, such mathematical formulae are referred 

to as expressions. For example, the Trade Strategist expression for the 

condition "Today's close price is less than yesterday's close price" is 

LessThan( Close(0), Close(-1) )

If you don't understand this expression, don't worry, just read on: It will 
be covered in detail later. 

Stock List
After you have created your strategy, you can run some simulations. But 

you need to stipulate which stocks will be used for the simulations. Trade 

Strategist allows you to gather stocks into lists, known as stock lists. 

When you select a stock list a simulation is run separately for each stock 

in the list, and for each strategy you have selected. 

Trading Specifications
Before a simulation can be performed, details such as the initial 

investment, the cost of making a trade (i.e. the commission), and the 

period of trading (i.e. start and finish dates) need to be entered. These 

are collectively known as trading specifications. 

Trading Results
At the conclusion of a simulation(s), Trade Strategist presents the user 

with a set of trading results. These are in tabular and chart form, and 

include things like the amount of money at the end of the simulation, the 



biggest percentage loss during the simulation, and the number of trades 

made. 

Signals
If you find a strategy that works well in simulations, you might be tempted 

to use it to guide your trading on the stock market. Trade Strategist can 

generate signals for you for a selection of strategies and stocks. The 

signals are the signals generated by the strategies for each stock for the 

most recent data available. Be careful: this data may not be 
completely up-to-date. Always check the dates given in the Signals 
Window before using the signals to guide real-life trading. 

Note that signals are only available after purchasing Trade Strategist 

Pro. 
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Strategies
Building strategies is what Trade Strategist is all about. The following 

sections describe how you create, write and remove strategies from your 

Trade Strategist document.

Adding a Strategy

1.  Open or create a new Trade Strategist document by selecting 
File > Open... or File > New.

2.  Click on the "Add Strategy" toolbar item, or select the menu item 
Strategy > Add Strategy.... You should see a "Strategy 
Inspector" window appear.

3.  Fill in the strategy name in the field provided.

4.  Proceed with writing the strategy as described in the following 
sections.

Editing a Strategy

1.  To edit an existing strategy, double click the strategy in the 
strategies table of the main window, or select the strategy and 
choose the menu item Strategy > Edit Selected Strategy....

Removing a Strategy

1.  To remove one or more existing strategies, select the strategies 
in the strategies table of the main window. 

2.  You then have three possibilities: press the backspace key, click 
on the "Remove Strategies" toolbar item, or select the menu item 
Strategy > Remove Selected Strategies. Note that the toolbar 
item may not be on your toolbar by default. You can add it by 
customizing the toolbar.

3.  To get back the deleted strategies, simply use undo.

Adding a Signal Rule

1.  Open the Strategy Inspector for a strategy by double clicking in 
the strategies table.

2.  Select the "Signal Rules" tab in the Strategy Inspector window.

3.  Click on the "Add Signal Rule" toolbar item, or select the 
Strategy > Add Signal Rule menu item

4.  If the new signal rule is not at the desired position in the list, 
simply drag it to where you want it.



Editing a Signal Rule

1.  Open the Strategy Inspector window, and select the "Signal 
Rules" tab.

2.  Add a new signal rule, or click on an existing rule in the Signal 
Rules table.

3.  Enter the expression for the signal rule in the editor under the list 
of rules. This is the expression which must evaluate to true if the 
signal is to be generated.

4.  Select an order type for the signal rule from the popup button 
underneath. "Market Open" stands for a market order carried out 
at the open of trading and "Market Close" is a market order at the 
close of trading. The other types are self explanatory.

5.  If you selected "Limit Order" or "Stop Order", you need to indicate 
what expression should be used for the price of the order. You 
can choose one of several standard price expressions from the 
"Order Price" popup button, or you can choose the "Custom..." 
option. If you opt for the latter, you need to enter an expression 
underneath that evaluates to a floating-point number, which will 
be used as the price of the order. You can use any valid 
expression that you choose. For example, you could enter "close(-
2)" to indicate the price should be set to the close price two days 
ago.

6.  If the signal rule is not in the desired position in the list of signal 
rules, drag it to a new position.

Removing a Signal Rule

1.  In the Strategy Inspector window, select the signal rule you would 
like to remove.

2.  Either press backspace, click on the "Remove Signal Rule" 
toolbar item, or select Strategy > Remove Selected Signal Rule 
menu item.

3.  To get back the removed signal rules, simply undo.

Reordering Signal Rules

1.  Open the Strategy Inspector window by double clicking a strategy.

2.  Click on the "Signal Rules" tab.

3.  Drag-and-drop the signal rules in the signal rules table into the 
order you desire.



Checking a Strategy
When you have written the signal rules for a strategy, or at least some of 

them, you may want to check that you have not made any mistakes. You 

can check certain things about your strategy, though not all, as described 

here. Even if your strategy passes the check, things could still go wrong 

when you try to use it in a simulation. This is because Trade Strategist 

can only check certain things when the strategy is actually used in a 

given context. 

1.  Open the Strategy Inspector window by double clicking a strategy.

2.  Click on the "Check Strategy" toolbar item, or select the Strategy 
> Check Strategy menu item. You should see a drawer with 
check results appear.

3.  If there are problems reported in the drawer, correct them, and re-
check.

4.  Close the drawer if desired by selecting the "Toggle Check 
Drawer" toolbar item. You can also open it again with this toolbar 
item.

Keeping Notes
Trade Strategist allows you to keep notes for each strategy that you 

make. This can be useful if you forget what the strategy is about, or want 

to give the strategy to someone else. 

1.  Open the Strategy Inspector window by double clicking a strategy.

2.  Click on the "Notes" tab.

3.  Type your notes in the "Notes" editor.

Writing a Description
Trade Strategist allows you to write a short description of each strategy 

that you create. This description is displayed in the main simulation 

window whenever a strategy is selected. It can be used as a brief 

reminder of what a strategy is about, for yourself in the future, or for 

anyone that you give your strategy to. 

1.  Open the Strategy Inspector window by double clicking a strategy.

2.  Click on the "Notes" tab.

3.  Type your description in the "Description" editor. You should see 
it change in the simulation window as you type.
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Expressions

Introduction to Expressions
Trade Strategist has its own mathematical language which you use to 

define conditions under which buy and sell signals should be triggered. 

The syntax of this language is simple, but is different to the usual 

mathematical syntax used by your high-school teacher. The 'normal' way 

of writing mathematical formulas is actually not very consistent. For 

example, take the equation 

1 + sin(30) 

This expression has two numbers, and two operators. The addition 

operator + appears between the subjects upon which it acts, i.e. 1 and 

sin(30). This is known as an 'infix' syntax. The other operator is the 

sin; it acts on the number 30. The sin is written in front of the subject it 

acts on, which is known as prefix syntax. 

To make all expressions consistent, Trade Strategist only makes use of 

prefix syntax. This is not difficult, just a bit unusual at first. In Trade 

Strategist, instead of 1+1, you would write add(1, 1). After using this 

approach for a short time you will appreciate it, because you don't need 

to remember lots of complicated syntactical rules: all expressions are 

structured exactly the same. 

For the same reason, Trade Strategist does not make use of natural 

language expressions. Although this seems like a good idea, in practice 

it is actually more complex. You end up having to learn and remember 

the words of the language, and the order in which they must appear. This 

is actually more trouble than learning the simple prefix approach adopted 

in Trade Strategist. 

Expression Syntax
So what is the syntax of Trade Strategist? Here is a simple example: 

GreaterThan( Close(-1), Close(0) ) 

The basic form of an expression is: keyword( argument_1, 

argument_2, ... ). The keyword states what operator or function is 

being applied. Note that it is case-insensitive, so ADD, Add, and add are 

all equivalent. The arguments are numbers or other expressions that the 

expression is applied to or which define the expression. Let's look in 



more detail at the expression above. 

The expression above, if written in English, would state 'Is the close on 

day -1 greater than the close price on day 0?'. If this were true for a 

particular date, the expression would have the value true; otherwise it 

would take the value false. The expression above is actually several 

subexpressions combined into one. One of the expressions is Close(-

1). The Close function takes a single argument, in this case -1, and 

has the value of the close price on the day corresponding to the index. 

So Close(-1) has the value of the close price on day -1. Similarly, 

Close(0) is the close price on day 0. 

The two Close expressions are subexpressions of the function 

GreaterThan. Not surprisingly, this function corresponds to the 

mathematical operator >. It has the value true if the first argument is 

greater than the second argument. So, in this case, it will be true if 

Close(-1) is greater than Close(0), or the close price on day -1 is 

greater than the close price on day 0. 

That's really all there is to the syntax of expressions in Trade Strategist...

simple. Note that the nesting of expressions can go as deep as you like. 

So we can change the above expression to the following: 

GreaterThan( Close( add(-2, 1) ), Close(0) ) 

This expression actually is equivalent to the original expression. The add

(-2, 1) subexpression just means 'add -2 to 1', and so has the value -

1. So the two expressions are exactly equivalent. This demonstrates how 

you can nest expressions inside other expressions. 

Evaluation Types
Each expression in Trade Strategist can be evaluated. The value of the 

expression is limited to a few basic types: float, integer, and boolean. A 

float is a floating point number, or decimal number, such as 5.6. An 

integer is a whole number like 5, and a boolean can take the values 

true and false. All expressions must evaluate to one of these three 

types. 

To give an example, the GreaterThan function evaluates to a boolean, 

i.e., it is either true or false. Another example is the Add function. This 

is more complex because the type it evaluates to depends on what its 

subexpressions evaluate to. For example, Add( 1, 1 ) evaluates to 2, 



which is an integer. However, Add( 1.1, 1) evaluates to 2.1, which is 

a float. 

Knowing the evaluation type of an expression is important, because 

there are restrictions on which types are allowed as parameters in any 

given expression. For example, you cannot add two booleans, so the 

add function can only accept integer and float subexpressions, but not 

boolean subexpressions. A logical operator, like or, on the other hand, 

only accepts booleans: you cannot write or( 1, 1 ) without getting an 

error. 

Time-Dependent Expressions
Time-dependent expressions are expressions that vary depending on the 

day they are evaluated. Simple examples include the close price 

(Close) and trading volume (Volume), and more complex examples are 

technical indicators like the stochastic oscillator (Stochastic). Each of 

these expressions have one or more arguments which stipulate a day or 

days. 

Time-independent expressions can also become time dependent if one 

of their subexpressions is time dependent. For example, the expression 

GreaterThan( Close(-2), Close(-1) ) is time-dependent, even 

though GreaterThan is not, since it has subexpressions which are time-

dependent. 

All time-dependent functions include a relative day index. If the 

expression is a top level expression, which isn't a subexpression, like 

Close(-1), the day index is relative to day 0, the day on which a trade 

is being considered. So Close(-1) is simply the close price on day -1, 

the day before the trade is to be made. But what about when a time-

dependent expression is a subexpression? 

Take the more complicated expression Sum( Close(-2), 5, -1). 

Since Sum is a top level, the day index argument (-1) indicates that the 

summation will be calculated for day -1. The 5 indicates that it is a sum 

over a range of 5 days. But what is actually being summed? The answer 

is Close(-2). If Close(-2) were a top-level expression, it would be 

the close price on day -2, but because it is a subexpression here, the -2 

is not taken with respect to day 0, but is taken relative to the enclosing 

function, Sum. 

What does all of this amount to? Well, the Sum expression above simply 



adds up the values of an expression on the days -5, -4, -3, -2, and -1. 

The expression being summed is Close(-2), so what we are actually 

adding up is the close price on days -7, -6, -5, -4, and -3. So the relative 

day index in the Close expression is relative to the enclosing expression 

Sum, not day 0. 
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Stock Lists
Stock lists are lists of stock ticker names (e.g. AAPL). A stock list can 

include zero, one, or more stocks. Stock lists allow you to group stocks 

together. When you simulate, you can select a single stock list, rather 

than lots of individual stocks. Simulations then get run for each stock in 

the list, and all results displayed together.

Adding a Stock List

1.  Open or create a new Trade Strategist document by selecting 
File > Open... or File > New.

2.  Click on the Add Stock List toolbar item, or select the menu item 
Data > Add Stock List. You should see an extra row appear in 
the Stock List Table.

3.  Enter a name for the stock list in the text field underneath.

4.  Enter the stock tickers in the list in the editor under the stock lists 
table. The tickers can be separated by space, return characters, 
commas, semi-colons, or colons. Any combination of these 
delimiters can also be used — you are not restricted to using only 
one type of delimiter in a stock list.

Editing a Stock List

1.  Select the row of the stock list you wish to edit in the stock lists 
table.

2.  Edit the name or list of stock tickers as desired.

Removing a Stock List

1.  To remove an existing stock list, select the stock list in the stock 
list table of the main window. 

2.  Either press backspace, click on the Remove Stock List toolbar 
item, or select the menu item Data > Remove Selected Stock 
List.

3.  To get back the removed stock list, simply undo.

Reordering Stock Lists

1.  Drag-and-drop the stock lists in the stock lists table into the order 
you desire. The order is not important in Trade Strategist, but 
may be beneficial for your own organisational purposes.

2.  To sort the stock lists, click on the header of the stock lists table 



column which you wish to use for sorting.
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Trading Specifications
Trading Specifications define the constraints on a simulation. Details 

such as the funds available initially, the cost of a trade, and the period of 

time over which the simulation is run.

Editing Trading Specifications

1.  Open an existing Trade Strategist document or create a new one.

2.  Enter trading specifications in the text fields provided in the lower-
right corner of the main simulation window.

Initial Investment
The Initial Investment is the funds available in the simulation at the 

beginning of the simulation. Set this to the amount you expect to begin 

trading with in order to make the simulation more relevant. 

Maximum and Minimum Single Purchase
Sometimes you might not want to put everything in one basket. You may 

want the simulation to only spend some of the available funds in any 

given trade, rather than all of them. You can set a limit on the maximum 

amount that can be spent in a single trade by setting the Maximum 
Single Purchase. This is the maximum that can be spent in total 
(including commission) in a single trade. If you don't want to have a 

maximum purchase limit to play a role in your simulation, just set it to a 

very large number, much larger than any amount you could expect to be 

available in funds during the simulation. 

Similarly, you may not want to spend less than a certain amount in any 

given trade. This might be because you don't want to lose too large a 

percentage to the commission. By setting the Minimum Single Purchase, 

you can set a limit on the minimum amount that can be spent in a single 

trade. If you don't want to have a minimum purchase limit, just set it to 

zero. 

Commission
The Commission is the cost of making a trade, which goes to a stock 

broker. In Trade Strategist, the cost of a buy trade is the same as a sell 

trade, and no distinction is made between different types of orders like 

market, limit, and stop. All trades cost the same amount, and are not 

dependent on the size of the trade being made. There is no charge if an 

order is placed which is not carried out (e.g., a limit order for which the 



limit price is not reached). 

Starting Date and Finishing Date
The Starting Date is the first date in the simulation time period. The 

Finishing Date is the last. Both dates are included in the simulation. Note 

that either date can fall on a day for which there was no trading, in which 

case the first trading day after the Starting Date, or first trading date 

before the Finishing Date is used. The format of the dates is mm/dd/yy. 
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Simulations
Once you've created at least one strategy and one stock list, and edited 

the trading specifications, you are finally ready to run a simulation. When 

you run a simulation, Trade Strategist retrieves the data for the stocks in 

the stock list you have selected, performs virtual trading with the 

strategies you have selected, and tabulates and charts the results for 

you.

Running a Simulation

1.  Open a Trade Strategist document or create a new one.

2.  Add any strategies and stock lists that you want to perform 
simulations for.

3.  Set the trading specifications.

4.  Select the strategies for which you would like to perform 
simulations in the Strategies Table. You can select multiple 
strategies by holding the SHIFT or APPLE keys while you click 
on the strategies.

5.  Select the stock list by clicking on the row containing the stock list 
in the Stock List Table.

6.  Press the Simulate toolbar item, or select the Analysis > Run 
Simulation menu item to run the simulation(s). You should see a 
progress bar indicating the simulation progress, and then a 
results window should appear containing results.

Stopping a Simulation

1.  If you decide you want to stop a simulation prematurely, click on 
the "Simulate" toolbar item, or select the Analysis > Stop 
Simulation menu item.

What days are included?
Despite what you might think, a simulation usually does not begin 

making trades on the first day for which trading data is available after the 

starting date stipulated in the Trading Specifications. The reason for this 

is that the expressions in a strategy cannot be properly evaluated unless 

a certain amount of data is available before the actual trading date. For 

example, if a strategy included a 20 day simple moving average, at least 

20 days of data is needed before the expressions in the strategy can be 

evaluated to determine if a trade should be made. That means there 

needs to be at least 20 spare days at the start of the simulation range. 

The extra data needed to start-up a simulation is sometimes referred to 



as the lookback. 

Note that this can also happen at the end of a simulation range, but 

usually doesn't. The reason is, strategies usually don't depend on data 

from the future (i.e. on or after day 0), so no spare days are needed. It is, 

however, possible to make unrealistic strategies, perhaps for 

comparative reasons, that do depend on future data, and these will also 

require spare days at the end of the simulation range. 

 
Home



  

Results
●     How do simulation results get 
presented? 

●     Final results 

●     Detailed results 

●     Chart results 

●     Synchronizing Scrollbars 

Results
After running a simulation or simulations, you get the results. This 

section explains the results that are given.

How do simulation results get presented?
The results of a simulation or simulations are presented in tabular and 

chart form. Two different types of tabular results are presented: final 

results and detailed results. Final results concern the simulation as a 

whole, and detailed results are presented day-by-day for the duration of 

the simulation. 

Results are available for every possible combination of a strategy and a 

stock, but are only presented for one combination at a time. You use the 

popup buttons in the toolbar to choose the stock and strategy of the 

displayed results. 

Final results
Final results are results at the end of the simulation period. These give 

you a general idea of how well a strategy performs, and how much risk it 

involves, without showing any specific day-to-day details. 

First trading day of simulation The first date in the simulation for which 

trading data was available. Note that this may not be be the same as the 

date you entered as the starting date in the Trading Specifications, if 

there was no trading on the day you entered. Note also that it is not 

necessarily the first day considered for trading in the simulation, because 

most simulations need spare days (i.e. lookback) at the beginning of the 

simulation range before the strategy expressions can be properly 

evaluated. 

Last trading day of simulation The last date in the simulation for which 

trading data was available. Note that this may not be be the same as the 

date you entered as the finishing date in the Trading Specifications. It is 

usually the last day considered for trading in the simulation, but for 

certain "unrealistic" strategies, which use data from the future (i.e. data 

for day "0" or days thereafter), it may not be. In such cases, the 

simulation needs spare days at the end of the simulation range in order 

to properly evaluate the strategy expressions. 

Total final value (cash and stock) This is the total value of the portfolio at 

the end of the simulation. This includes all cash and stock. The monetary 



value of the stock is evaluated at the close of the last day for which there 

is data; no commission is deducted in the conversion. 

Final balance The cash available upon completion of the simulation. It 

does not include any stock owned at the end of the simulation. 

Number of shares owned The number of shares owned in the stock upon 

completion of the simulation. 

Number of buy trades made The total number of times that a buy trade 

was made during the simulation. 

Number of sell trades made The total number of times that a sell trade 

was made during the simulation. 

Maximum portfolio value during simulation The maximum total value of 

the portfolio on any day of the simulation. The total value includes cash 

and stock owned. The value of the stock is converted to cash at the 

close price, with no commission deducted. 

Minimum portfolio value during simulation The minimum total value of the 

portfolio on any day of the simulation. The total value includes cash and 

stock owned. The value of the stock is converted to cash at the close 

price, with no commission deducted. 

Percentage of winning trade combinations A trade combination is defined 

as a series of trades initiated with no shares owned, and ending with no 

shares owned. The simplest example of such a combination is buying 

some shares, and then selling them all again. The combination only ends 

when the number of shares owned drops to zero. So a combination 

could consist of two buys and a sell, for example. This result is the 

percentage of combinations for which the total value of the portfolio 

increases, i.e., a winning trade combination. 

Average percentage win for winning trade combinations This is the 

expected percentage increase in portfolio value for any winning 

combination averaged over the simulation. 

Standard deviation of percentage win for winning trade combinations 

This is the standard deviation of the percentage increase in portfolio 

value for winning combinations. It is an indication of how much the 

percentage increase varies on average from the mean winning 



percentage. 

Average percentage loss for losing trade combinations A losing trade 

combination is a trade combination that results in a decrease in portfolio 

value. This result is the expected percentage decrease in portfolio value 

for any losing combination averaged over the simulation. 

Standard deviation of percentage loss for losing trade combinations This 

is the standard deviation of the percentage decrease in portfolio value for 

losing combinations. It is an indication of how much the percentage 

decrease varies on average from the mean losing percentage. 

Largest single day gain in portfolio value The maximum gain in the value 

of the portfolio (stocks plus cash) during the simulation, from the close on 

one day to the close on the next. This is expressed as a percentage of 

the first of the two close prices. 

Largest continuous multi-day gain The maximum continuous percentage 

gain in the value of the portfolio (stocks plus cash) during the simulation. 

"Continuous" in this sense means that the value of the portfolio must 

increase from day close to day close, without decreasing. A "continuous 

gain" can occur over several days. In order for the gain to continue, only 

the close price has to increase from day to day: within a single day, the 

price may rise or fall. The gain is expressed as a percentage of the first 

of the close prices in the period of the continuous gain. 

Largest single day loss in portfolio value The maximum loss in the value 

of the portfolio (stocks plus cash) during the simulation, from the close on 

one day to the close on the next. This is expressed as a percentage of 

the first of the two close prices. 

Largest continuous multi-day loss The maximum continuous percentage 

loss in the value of the portfolio (stocks plus cash) during the simulation. 

"Continuous" in this sense means that the value of the portfolio must 

decrease from day close to day close, without increasing. A "continuous 

loss" can occur over several days. In order for the loss to continue, only 

the close price has to decrease from day to day: within a single day, the 

price may rise or fall. The loss is expressed as a percentage of the first 

of the close prices in the period of the continuous loss. 

Detailed results
Detailed results are day-by-day results. These give you specific details 



about the day-to-day performance of a strategy: when it signals to buy or 

sell, how much the portfolio value changes each day, etc. You can use 

these results to see how your strategies can be improved. 

The detailed results are presented in pairs of rows in a table. The first 

row shows the signal that was generated by the strategy before the open 

of trading. The row directly below the row showing the signal presents 

the results for the trading day. So, remember that the signal shown in a 

row applies to the trading day in the row directly below it. 

The results shown are as follows: 

Date The date for which the detailed results are given. 

Close The close price of the stock for the day in question. Note that this 

price is adjusted for dividends and stock splits. 

% C.P. (Percentage Change in Price) The change in the close price from 

the previous day, as a percentage of the price on the previous day. 

Total Value The total value of the portfolio (cash and shares) at the close 

of the day in question. Shares are converted to cash at the close price 

with no commission deducted. 

% C.T.V. (Percentage Change in Total Value) The change in total value 

of the portfolio from the previous day, as a percentage of the price on the 

previous day. 

C.S.O. (Change in Shares Owned) The change in the number of shares 

owned from the previous day. A positive number indictates more shares 

are owned on the current day than the previous day; a negative number 

indicates less shares are owned on the current day. 

S.O. (Shares Owned) The number of shares owned at the close of the 

day. 

Balance The cash balance at the close of the day. This does not include 

any share value. 

Open The open price of the stock for the day in question. Note that this 

price is adjusted for dividends and stock splits. 



High The high price of the stock for the day in question. Note that this 

price is adjusted for dividends and stock splits. 

Low The low price of the stock for the day in question. Note that this 

price is adjusted for dividends and stock splits. 

Volume The trading volume of the stock for the day in question. 

Chart results
Chart results, like detailed results, are day-by-day results. But chart 

results are presented graphically, and so are much more useful for 

quickly identifying when a strategy performs well, and when it doesn't. 

Total Value of Portfolio This shows the sum value of shares-owned, and 

cash, as a function of time. 

Buy and Sell Signals This chart indicates when buy and sell signals were 

generated by the strategy. Buy signals point upward, and are green in 

color. Sell signals are red, and point downwards. 

Open-High-Low-Close Price The standard bar chart for price. The day 

range is indicated by the vertical bar. The open price is indicated by a 

tick to the left, and the close price by a tick to the right. 

Trading Volume The trading volume shown as a histogram. Each vertical 

line represents the volume on a single trading day. 

Synchronizing Scrollbars
If you are dealing with results for several different stocks and/or 

strategies, you may wish to compare them directly. Checking the 

'Synchronize Scrollbars' checkbox can help in this case: When you 

select a different stock or strategy, the newly displayed results will be 

scrolled to the position of last results displayed, meaning you don't need 

to manually scroll to find the relevant place in the data. The scrollbars of 

both the Detailed Results Table and Charts are synchronized when the 

checkbox is selected. 
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Signals
If you find a strategy that works well for you in simulations, you might be 

tempted to use it in real-life trading. Make sure you have thoroughly 

tested the strategy before you do, and are convinced that the results you 

are getting in the simulations are accurate, and not caused by a bug in 

Trade Strategist, for example. Even if the simulation results are accurate, 

always bear in mind that success in the past is no guarantee for the 

future: just because a strategy works well on past data does not mean it 

will necessarily be successful in the future. 

If after these considerations you still wish to use Trade Strategist to 

guide your trading, you are ready for signals. Signals are generated by 

Trade Strategist for a set of strategies and a selection of stocks. The 

signals are based on the most recently available data. Beware that this 
may not be up-to-date, so always check carefully that the signals 
you see apply to the trading day which you are using them for. 

Signals are only available after purchasing Trade Strategist Pro. 

Generating Signals

1.  Open a Trade Strategist document or create a new one.

2.  Add any strategies and stock lists that you want to generate 
signals for.

3.  Select the strategies for which you would like to generate signals 
in the Strategies Table. You can select multiple strategies by 
holding the SHIFT or APPLE keys while you click on the 
strategies.

4.  Select the stock list by clicking on the row containing the stock list 
in the Stock List Table.

5.  Press the Signals toolbar item, or select the Analysis > 
Generate Signals. You should see the signals window appear. 
Wait for Trade Strategist to download the required data and 
generate the signals.

6.  If you decide you don't want to generate the signals anymore, 
you can simply close the signals window before Trade Strategist 
is finished generating them.

Which day are the signals for?
You need to be careful when considering the signals that Trade 

Strategist generates. For each combination of a strategy and a stock, 

Trade Strategist shows the last date (ie Last Trading Day) for which it 



was able to retrieve data. The signal generated assumes that this date is 

the last date for which trading occurred for the stock shown. The signal is 

for the trading day which follows the date shown. Trade Strategist 

doesn't display the date that the signal is for, because this would require 

it to consider weekends, public holidays, stock market holidays etc. You 
should carefully check the date shown for each signal, to be sure 
that the signal is for the trading day you expect it to be for. 
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Charts
In order to create good strategies, you need to know how the 

expressions you are using behave. Trade Strategist allows you to make 

charts of expressions, so that you can compare them, and see how they 

can best be utilized. You can even export the data you calculate to other 

applications like spreadsheets. In this way, Trade Strategist can be used 

as a powerful financial calculator. 

Opening the Chart Window
To open the chart window, either select the menu item 

Window > Charts, or click the Charts toolbar item. 

Adding Plots

1.  Click the round + button under the plot area.

2.  Fill in a name for the plot. This name must be different to all other 
plot names.

3.  Choose a color for the plot by clicking the color well.

4.  Fill in a valid Trade Strategist expression. This expression must 
have a floating point value.

Selecting Plots

1.  To select an existing plot, select its name from the pop up button.

2.  Examine, remove, or edit the selected plot as desired.

Removing Plots

1.  Select the plot you wish you remove by selecting its name in the 
pop up button.

2.  Click the round – button under the plot area.

Hiding Plots
If you have added many plots to the chart window, you may wish to hide 

some of them. To do this, either 

1.  Select a plot you wish you hide by selecting its name in the pop 
up button.

2.  Select the Hide check box.

3.  Repeat for each plot you wish to hide.



or 

1.  Click the Hide All button to hide all plots.

2.  Select any plots you wish to display, and deselect the Hide 
checkbox for those plots.

Displaying Plots

1.  Make sure that the plots you wish to view are not hidden.

2.  Enter a start date (mm/dd/yy) and end date for the chart.

3.  Enter the ticker of a single stock.

4.  Click the 'Plot' button, and wait. Trade Strategist may need to 
download data, so this could take a moment.

Saving Plots
Plots are automatically saved along with your strategies. Simply save 

your document, and your plot expressions will be saved so that next time 

you open your document, they will be unchanged. 

Exporting Chart Data
The Chart Window is not only useful for creating plots of data, it can also 

be used as a calculator to generate data for other applications such as 

spreadsheets. Trade Strategist has access to a very wide range of 

Technical Analysis indicators, which can be combined in infinitely many 

ways. In this sense, Trade Strategist is much more powerful than a 

spreadsheet, and can be used to complement the strengths of a 

spreadsheet application. 

You can copy the data generated for a plot by simply choosing Copy 

from the Edit menu after you have created some plots. The data is put 

on the clipboard in tab-delimited form, and can be pasted directly into 

other applications. Only the data of visible plots is put on the clipboard — 

data for hidden plots is not included. 

You can export data to file by selecting Data > Export Chart Data... after 

creating your plots. Data is exported to file in comma-separated values 

(CSV) format, which can be imported into other applications. 

Limitations
The demo and standard registered versions of Trade Strategist place a 



limit of five plots in the Charts Window. To create new plots, you either 

have to delete old ones, or purchase Trade Strategist Pro, which allows 

you to create and save an unlimited number of plots. 
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Data
Trade Strategist would be useless without historical data. This section 

explains where the data comes from, how it is stored in the Trade 

Strategist database, what types of data can be used, and how you can 

export data to other applications. 

Data Sources
You can set the data source that Trade Strategist uses in the 

Preferences panel. For general stock data from around the world, the 

best choice is the Yahoo! Finance data source. This site provides 

historical data for all major US and international markets, in addition to 

charting and analysis. The symbols you enter in your stock lists should 

correspond to the symbols given on the Yahoo! Finance web site. You 

can do a symbol search on the web site to find the symbol to use for a 

given company. 

The OANDA data source is for foreign exchange rates (Forex). Only 

close-of-trade rates are available, and data is only available for up to 

2000 days. The symbols you need to enter, in order to access the 

OANDA currency rates, take the form CURRENCY1_CURRENCY2. This 

gives the exchange rate from CURRENCY1 to CURRENCY2. For example, 

to get the US dollar to Euro exchange rate, enter USD_EUR for the 

symbol. 

If you have access to your own source of data, there are two ways you 

can use it: the simplist is to choose the Comma-Separated Values (CSV) 

File data source, and then populate a folder with files containing the data 

in a given format. The second way is to use the Software Development 

Kit (SDK), but this requires some experience in programming. Both 

approaches are discussed further below. 

Types of data available
The Random source provides daily data, including the open, high, low, 

and close prices, in addition to the trading volume. This data is entirely 

fictional. 

Yahoo! provides daily equities data, including the open, high, low, and 

close prices, in addition to the trading volume. 

OANDA provides foreigen exchange (Forex) daily close-of-trade data for 

up to 2000 days. The symbol for an exchange rate is 

http://finance.yahoo.com/
http://www.oanda.com/


CURRENCY1_CURRENCY2. For example, US dollar to Euro is entered in 

Trade Strategist as USD_EUR. 

The Comma-Separated Values (CSV) File data source provides the 

open, high, low, and close prices, and the volume. You must provide this 

data to Trade Strategist as described below if you wish to use this data 

source. 

Data adjustments
You can choose how you want price data to be adjusted in the 

Preferences panel. Data can be adjusted for stock splits and/or dividend 

payments. Not all data sources allow for price adjustments. If 

adjustments are not allowed, the adjustment popup items will be 

disabled. 

Downloading data
As long as you have your data preferences configured correctly in the 

Preferences panel, data should be downloaded automatically as needed 

when Trade Strategist runs a simulation or plots a chart. Data will either 

be downloaded, or read from file, depending on the data source you 

have selected in the Preferences. 

You can also force Trade Strategist to retrieve data for a particular stock 

list. This might be useful if you want the data to be added to your 

database (see below) so that you can later test your strategies offline. To 

explicitly download data for a stock list: 

1.  Set the range of dates in the main simulation window.

2.  Select the stock list.

3.  Choose the menu item Data > Retrieve Stock List Data

You can cancel the data retrieval by selecting Data > Stop Data 
Retrieval. 

Supplying your own data
If you have access to your own source of data, one simple way to use it 

is to choose the Comma-Separated Values (CSV) File data source. This 

source takes its data from files in a folder of your choosing. You need to 

find a way to populate the folder with files containing stock data; each file 

contains data for one stock, and the file name is chosen to indicate what 

type of data is included, as explained further below. After you have 



entered the path to the directory in the Preferences panel, and chosen 

the Commas-Separated Values (CSV) File data source, Trade Strategist 

will look in the directory for data whenever it is required. 

To make use of the CSV File data source you need to adhere to some 

basic rules about formatting and file names. Trade Strategist expects file 

names to be of the following form:  
<STOCKTICKER>__<SPLITOPTION>__<DIVOPTION>.csv  
(Note that the format includes double underscores)  
After the stock ticker comes a split adjustment option, which can either 

be SPLITADJ or SPLITUNADJ, for split-adjusted and split-unadjusted 

data, respectively. The dividend adjustment option follows; it can be 

either DIVADJ or DIVUNADJ, which stand for dividend-adjusted and 

dividend-unadjusted. For example, the name of a file containing split and 

dividend adjusted data for Apple would be AAPL__SPLITADJ__DIVADJ.

csv. 

Trade Strategist also expects the data in each file to be formatted in a 

particular way. Each line should include: a date, like 21-Jul-04; the 

open price; the high price; the low price; the close price; and the trading 

volume. Anything appearing on the line after the volume is simply 

ignored. The entries on each line should be separated by commas, and 

the lines should be in order from oldest to newest data. Here is some 

data in the correct format: 

21-Jul-04,32.42,32.71,31.34,31.62,5379600
22-Jul-04,31.25,31.73,31.06,31.68,5966400
23-Jul-04,31.53,31.75,30.48,30.70,4885200
26-Jul-04,30.85,31.45,30.78,31.26,7034500
27-Jul-04,31.80,32.75,31.57,32.43,7589400
28-Jul-04,32.31,32.41,31.16,32.27,5090200

In addition to the CSV File data source, users familiar with Cocoa 

programming can use the Software Development Kit (SDK) to add their 

own data sources to Trade Strategist. The data source used by Trade 

Strategist can be selected in the Preferences panel. Using the SDK, any 

data source could be used, from a simple file, to a database, or 

commercial data provider. 

The database
Trade Strategist includes a built-in database, which can be used to store 

any data that gets retrieved while you are working. This database serves 

two purposes: it allows you to use Trade Strategist when you are offline, 



and it can make retrieving data considerably faster, because data that is 

already found in the database does not need to be downloaded again. 

The behavior of the database can be configured in the Preferences 

panel. You have a number of options available to you. For example, you 

can opt to only use the database for data, and never download new data. 

Or you can choose to always download new data, and never access the 

database. Other combinations are also possible. 

It is useful to know a little about how the database works. In particular, it 

is important to realize that the database stores data separately for each 

stock, data source, and combination of adjustment options. In other 

words, it is possible that the database contains several data sets for any 

one stock: one for each combination of data source and adjustments. For 

example, a database may contain separate data sets for Apple (AAPL) 

from Yahoo! and some other data source, and different sets for split-

adjusted and split-unadjusted options. The particular data set used 

depends on the choice of data source and adjustment options that you 

have selected in the Preferences panel. A data set for one data source 

will never be used if another data source is selected. 

The database itself is simply a file. It is located in the folder Library/

Application Support/Trade Strategist in your home directory. 

The file is called PricesDatabase.tsdb. If at any point you want to 

empty the database, simply quit Trade Strategist, and throw this file in 

the Trash. Trade Strategist will create a new database when it next tries 

to retrieve or store data. 

Data for non-US Stocks
Trade Strategist can run simulations for any stock for which historical 

data is available from Yahoo! Finance (US). Data for many non-US 

stocks is provided by Yahoo, so there is a reasonable chance that the 

data you seek will be there, but if you are unsure, you should check the 

web site directly. 

Note that non-US stocks usually have an extension to the stock ticker. 

For example, KPN.AS is the Dutch company KPN, listed on the 

Amsterdam Stock Exchange. To find out what the stock extension is for 

your stock, go to Yahoo! Finance (US) and perform a search for the 

stock. 

Exporting data

http://finance.yahoo.com/
http://finance.yahoo.com/


You cannot directly export the data that Trade Strategist downloads, but 

you can use the chart window to calculate any function, and export or 

copy the chart data. You can then import or paste into a spreadsheet or 

charting program, for example. 

If you just want to export the historical data, rather than the values of a 

function or indicator, you can simply use price functions in the chart 

window to generate the data you want. For example, if you want the 

close price and open price, simply create two plots in the Chart Window, 

and enter the expressions close(0) and open(0). Plot the data, and 

then either copy, or choose the Data > Export Chart Data... menu item. 
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Extending
Trade Strategist provides Cocoa developers with a way to extend its 

functionality. In particular, new expressions can be introduced, and 

specialized data sources. This section describes briefly how you can do 

this. 

What is an SDK?
Despite what you might think, an SDK is not an extreme terrorist 

organization, it is a Software Development Kit (SDK). With the Trade 

Strategist SDK you can write plugins for Trade Strategist, which get 

loaded and extend the functionality of the application. In particular, you 

can add new functions and indicators, and/or new data sources. 

Adding New Expressions
Trade Strategist includes a wide variety of different Technical Analysis 

functions and indicators, which can be combined in an almost infinite 

variety of ways. But sometimes there could be functions that are not 

included, or you may want much more advanced functionality, such as is 

provided by artificial intelligence algorithms. In such instances, the Trade 

Strategist SDK could be the answer. 

With the SDK, you can write new expression classes that are integrated 

into Trade Strategist as if they were built-in. They can be used in 

strategies, for charting, and are even included in the Expression Library. 

Adding New Data Sources
You can also add new data sources with the Trade Strategist SDK. 

Trade Strategist has a number of free data sources already built in, but 

you may want to add a different source. Perhaps you are subscribed to a 

particular data provider, and would like to access their historical data in 

Trade Stratgist. Or perhaps you have a database full of historical data 

that you want to use in Trade Strategist. With the SDK, solutions to these 

problems only require a little Cocoa programming experience, and a bit 

of time. 

How Does it Work?
The Trade Strategist SDK allows you to write plugins in Objective-C/

Cocoa. Tools for developing plugins are provided freely by Apple, and 

may even already be installed or ready for installation on your hard disk. 

If not, you can download them from the Apple developer site. 

http://developer.apple.com/


When you have the Xcode Developer Tools installed, you can use the 

SDK provided with your copy of Trade Strategist to compile a plugin with 

your functions and data sources. You then install this plugin in a folder, 

and Trade Strategist will load it next time it starts up. You then have 

access to the functions and data sources from your plugin from within 

Trade Strategist. 

Getting Started
Details of how you write, compile, and install Trade Strategist plugins are 

provided in the documentation accompanying the SDK. Example code is 

also available, which you can compile to create plugins, and see how it 

all works. Make a copy of the SDK somewhere on your hard disk, and 

you are ready to get started. 

Limitations
The Trade Strategist SDK only works with the Pro version of Trade 

Strategist. If you are using the demo or standard versions, plugins will 

not be loaded by Trade Strategist at start up. In order to use plugins in 

Trade Strategist, you need to upgrade to a Trade Strategist Pro license. 
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Registering
There are a few different license levels available in Trade Strategist. 

Each entitles you to use certain features of Trade Strategist. This section 

tells why you should buy a license, and what features each license level 

allows. 

The Demo Version
When you download Trade Strategist for the first time, you get the demo 

version of the application. This has some restrictions: 

●     You can only launch the application 40 times or on 20 different days 
whichever comes first.

●     You can only make up to 5 charts at any time.

●     You can't use Advanced functions (see the Expression Library to see 
which functions are 'Advanced').

Other restrictions on the demo version are the same as for the Standard 
version, described below. 

The Standard Version (discontinued)
Previously there was a version of Trade Strategist known as the 

Standard version. The Standard version is no longer available for 
purchase. This version has access to advanced functions and unlimited 

charts, unlike the demo version. However, there are some limitations: 

●     You can't generate signals with your strategies.

●     You can't load plugins created with the Software Development Kit 
(SDK).

If you purchased the Standard version in the past, and decide you need 
the extra functionality provided by the Pro version, you can purchase an 
upgrade, which is cheaper than a full Trade Strategist Pro license. 

The Pro Version
Purchasing a Trade Strategist Pro license gives you access to the full 

functionality of Trade Strategist, including advanced functions, signal 

generation, unlimited charts, and loading of plugins. If you are serious 

about your trading, you will probably want a Trade Strategist Pro license. 

How do you purchase a license?
There are two ways to purchase Trade Strategist. The first involves 

selecting the menu item Trade Strategist > Purchase Trade Strategist 
and selecting the version you want. This will open a wizard, and allow 



you to purchase the software without ever leaving the application, 

provided you are connected to the internet. This is the easiest way to 

purchase the software, and you will not even have to fill in a serial 

number. 

The second way you can purchase Trade Strategist is to go to the Trade 
Strategist web site, and follow the link to eSellerate, where you can 

register online. 

Who carries out the transaction?
Transactions to purchase Trade Strategist are handled by eSellerate, a 

well-known software ecommerce provider. It is a reputable company, and 

transactions are secure. They accept all major credit cards. 

Why Purchase a Trade Strategist License?
The Mac market is not large, and fringe areas of Mac software 

development are often undernourished as a result. Technical Analysis is 

a niche market itself, so developers of Technical Analysis software for 

the Mac are developing for a niche inside a niche. That's a small market! 

To be able to continue developing their software, developers either have 

to charge a high price for it, or sacrifice quality. Many resort to 

developing cross platform software, which tends to lead to a reduction in 

quality, and thus user experience on each platform. 

Trade Strategist is a Mac-only Technical Analysis program. Our goal is to 

create a good user experience, as well as a reasonably powerful piece of 

Technical Analysis software. We are targeting a very small market, and 

attempting to keep the software very affordable at the same time. 

If you like Trade Strategist, you should pay the small fee we ask for it. 

The more users that pay the fee, the more time we can justify spending 

developing it, and the better it will become. So, if you want good, 

reasonably-priced Technical Analysis software for the Mac, please 

consider purchasing Trade Strategist. 

If you are not that idealistic, you should still buy a license, because 

licensed users get functionality not found in the demo version. (See 

above for details.) 
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More Info
Want to know more about Trade Strategist or Technical Analysis in 

general? This section tells you where to look. 

Where can I learn more about Trade Strategist?
Try the Trade Strategist web site: www.trade-strategist.com. While you're 

there, join the trade-strategist-users mailing list, and discuss your 

strategies and ideas for Trade Strategist with other users. 

Where can I learn more about Technical Analysis?
There are lots of web sites dedicated to Technical Analysis. Use a 

search engine to find your favorites. 

A good site for learning Technical Analysis is www.clearstation.com. You 

can use Yahoo! Finance for stock data and basic charting, and the 

Stocks and Commodities Magazine web site has some very interesting 

articles about Technical Analysis, though a small fee is charged for many 

of them. TADOC lists and describes many of the functions used in Trade 

Strategist, and how they can be used. 

The book Technical Analysis from A to Z by Steven B. Achelis is a good 

introduction and resource. It is browsable freely on the internet here. 
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Introducing Trade Strategist

What is Technical Analysis?
Technical Analysis is a field of finance in which trading decisions are based on measurable quantities, rather 

than the psychology of the trader. A 'technical' trader makes use of charts and indicators that derive from price 

and other data to decide when to buy or sell stock.

Technical analysis is also popular with amateur traders, as witnessed by the success of web sites like Yahoo! 
Finance. These sites include charts and indicators, in addition to data like price and volume. But how do you 

decide which indicators are most profitable? And how should you combine the available indicators into an 

effective trading strategy? 

What is Trade Strategist?
Trade Strategist is a tool designed to help you develop an effective trading strategy by utilizing the various 

indicators of Technical Analysis. A common problem faced by amateur traders is a lack of faith in their adopted 

trading approach. If you have traded yourself, you probably know the feeling: you see your stock plummeting in 

price, and even though you reason that it will rebound, you end up selling the bottom and swallowing a big 

loss. Your trading is being governed by your psychology, rather than by a rational, well-tested, and most-

importantly, mechanical strategy.

What if you could see how effective a trading strategy was by testing it on historical data, before you begin to 

use it? That's what Trade Strategist is all about. You combine the indicators you find on financial web sites into 

formulas which trigger buy and sell signals. Trade Strategist takes your 'strategy', downloads historical data 

from the web for the stocks you would like to test, and runs through the data making virtual trades based on 

your strategy. Within a few seconds you can see how much you would have made or lost had you adopted the 

strategy. If it works well, you try it on other stocks; if it doesn't, you discard or improve it. It's a bit like paper 

trading at high speed!
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Concepts in Trade Strategist

Simulation
Trade Strategist is designed to carry out trading simulations. It processes downloaded stock data, acting on 

signals from a trading strategy to buy or sell stock, as if it were really trading in the stock on the stockmarket. If 

on a given date, the trading strategy triggers a buy signal, trade strategist performs the calculations to 

determine how much stock could be bought with the money available, and updates a virtual account, as if the 

trade were actually made. It then moves onto the next date, and repeats the process. At the end of the time 

period, it calculates how much the account is worth, and displays the results. 

This whole process is known as a simulation. A simulation is always for a single stock and a single strategy, 

over a given period of time. You can perform multiple simulations at once in Trade Strategist, for many stocks 

and/or strategies. 

Time Line
Time plays an important role in Trade Strategist, and as a user, it is important that you understand how it is 

treated. Trade Strategist works with daily data. Before you perform a simulation, you enter the range of dates 

for which it will be performed. The simulator them moves through this range one day at a time, determining 

whether a trade should be made each day, and making the trade if necessary. 

When defining strategies in Trade Strategist, a relative time scale is used. You can think of this in terms of a 

time line: The day the simulator is analysing to determine if a trade should be made is taken to be day 0. Price 

data is only available up to and including day -1. Day 1 is the day after the day being considered for a trade, i.
e., it is in the future. The best way to think about it is to pretend you are deciding whether to make a trade after 

the close of trading on day -1. You have data up to and including day -1, but don't know the prices for the next 

day, day 0. You have to decide based on the data you already have whether to make a trade or not on day 0. 

This is exactly what a strategy does: it decides based on data up to day -1 whether to trigger a buy or sell 

signal on day 0. 

Strategy
By now you probably have a reasonable idea what a strategy is. A strategy is effectively a formula which takes 

as input, data for a single stock, up to and including day -1, and can generate a buy or sell signal for day 0. It 

does not indicate how much stock should be bought or sold, but if a signal is generated, it does indicate the 

type of order that should be made (e.g. market order, limit order, etc.). 

Signal Rule
A strategy includes zero or more signal rules. A signal rule is an expression which when true, generates a 

signal. Three types of signals are possible: buy, sell, and hold. A buy indicates an order to buy stock should be 

made for day 0, though whether or not the trade is actually made will depend on the type of order, and the 



price data for day 0. For example, if a signal for a limit order to buy is generated, whether the trade is actually 

made will depend on whether the price on day 0 drops below the limit order price. A sell signal obviously 

indicates an order to sell stock. A hold indicates that no order should be made on day 0. 

Signal rules are evaluated in the order they are entered in the strategy. A trade order is generated for day 0 by 

the first signal rule encountered that evaluates true for a given date. If no rule evaluates true, a hold signal is 

generated. Signal rules can be reordered. 

Order Type
Order types in Trade Strategist basically correspond to the types of orders that can be placed on the stock 

market. The options are market, limit, and stop. Each order type is available for buying and selling stock. For 

example, if you create a sell signal rule, and set the order type to stop, you are actually creating what is 

commonly called a 'stop loss' order. 

If you are not familiar with these order types, it is recommended that you read more about them in a book 

about stock trading, as we don't have the space here to describe how the stock market works in any detail. 

A market order will always result in a trade in Trade Strategist. The price of a market order depends on the 

time at which the order is placed. In Trade Strategist you have a choice between having the market order 

placed at the open of trading, or the close of trading (on day 0, of course). Other times are not allowed, 

because Trade Strategist does not have access to price data at specific times other than for the open and 

close of trading. 

Stop and limit orders are different, because they are triggered when the price crosses a given value. In real 

life, these orders are placed at an absolute price. For example, we could make a limit order to buy stock at 

$3.45. If the stock price dropped below $3.45, our trade would go through. However, in a simulation, it may not 

make much sense to set an absolute price value for an order, because the price of the order will usually 

depend on the day it is being made. Trade Strategist allows you to set the price of stop and limit orders in 

relation to other prices, such as the previous day's close price, or to create custom expressions to calculate a 

price from the data available. For example, instead of setting a limit order at $3.45, in a strategy we could 

create an expression that sets the price to 1% less than the previous day's low price. 

Expression
In order to construct signal rules, you need a mathematical language for defining when a signal should be 

generated. You need a means of expressing what conditions need to be met for a particular signal to be 

generated. In Trade Strategist, such mathematical formulae are referred to as expressions. For example, the 

Trade Strategist expression for the condition "Today's close price is less than yesterday's close price" is 

LessThan( Close(0), Close(-1) )



If you don't understand this expression, don't worry, just read on: It will be covered in detail later. 

Stock List
After you have created your strategy, you can run some simulations. But you need to stipulate which stocks 

will be used for the simulations. Trade Strategist allows you to gather stocks into lists, known as stock lists. 

When you select a stock list a simulation is run separately for each stock in the list, and for each strategy you 

have selected. 

Trading Specifications
Before a simulation can be performed, details such as the initial investment, the cost of making a trade (i.e. the 

commission), and the period of trading (i.e. start and finish dates) need to be entered. These are collectively 

known as trading specifications. 

Trading Results
At the conclusion of a simulation(s), Trade Strategist presents the user with a set of trading results. These are 

in tabular and chart form, and include things like the amount of money at the end of the simulation, the biggest 

percentage loss during the simulation, and the number of trades made. 

Signals
If you find a strategy that works well in simulations, you might be tempted to use it to guide your trading on the 

stock market. Trade Strategist can generate signals for you for a selection of strategies and stocks. The 

signals are the signals generated by the strategies for each stock for the most recent data available. Be 
careful: this data may not be completely up-to-date. Always check the dates given in the Signals 
Window before using the signals to guide real-life trading. 

Note that signals are only available after purchasing Trade Strategist Pro. 
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Strategies
Building strategies is what Trade Strategist is all about. The following sections describe how you create, write 

and remove strategies from your Trade Strategist document.

Adding a Strategy

1.  Open or create a new Trade Strategist document by selecting File > Open... or File > New.

2.  Click on the "Add Strategy" toolbar item, or select the menu item Strategy > Add Strategy.... You 
should see a "Strategy Inspector" window appear.

3.  Fill in the strategy name in the field provided.

4.  Proceed with writing the strategy as described in the following sections.

Editing a Strategy

1.  To edit an existing strategy, double click the strategy in the strategies table of the main window, or 
select the strategy and choose the menu item Strategy > Edit Selected Strategy....

Removing a Strategy

1.  To remove one or more existing strategies, select the strategies in the strategies table of the main 
window. 

2.  You then have three possibilities: press the backspace key, click on the "Remove Strategies" toolbar 
item, or select the menu item Strategy > Remove Selected Strategies. Note that the toolbar item may 
not be on your toolbar by default. You can add it by customizing the toolbar.

3.  To get back the deleted strategies, simply use undo.

Adding a Signal Rule

1.  Open the Strategy Inspector for a strategy by double clicking in the strategies table.

2.  Select the "Signal Rules" tab in the Strategy Inspector window.

3.  Click on the "Add Signal Rule" toolbar item, or select the Strategy > Add Signal Rule menu item

4.  If the new signal rule is not at the desired position in the list, simply drag it to where you want it.

Editing a Signal Rule

1.  Open the Strategy Inspector window, and select the "Signal Rules" tab.

2.  Add a new signal rule, or click on an existing rule in the Signal Rules table.



3.  Enter the expression for the signal rule in the editor under the list of rules. This is the expression which 
must evaluate to true if the signal is to be generated.

4.  Select an order type for the signal rule from the popup button underneath. "Market Open" stands for a 
market order carried out at the open of trading and "Market Close" is a market order at the close of 
trading. The other types are self explanatory.

5.  If you selected "Limit Order" or "Stop Order", you need to indicate what expression should be used for 
the price of the order. You can choose one of several standard price expressions from the "Order 
Price" popup button, or you can choose the "Custom..." option. If you opt for the latter, you need to 
enter an expression underneath that evaluates to a floating-point number, which will be used as the 
price of the order. You can use any valid expression that you choose. For example, you could enter 
"close(-2)" to indicate the price should be set to the close price two days ago.

6.  If the signal rule is not in the desired position in the list of signal rules, drag it to a new position.

Removing a Signal Rule

1.  In the Strategy Inspector window, select the signal rule you would like to remove.

2.  Either press backspace, click on the "Remove Signal Rule" toolbar item, or select Strategy > Remove 
Selected Signal Rule menu item.

3.  To get back the removed signal rules, simply undo.

Reordering Signal Rules

1.  Open the Strategy Inspector window by double clicking a strategy.

2.  Click on the "Signal Rules" tab.

3.  Drag-and-drop the signal rules in the signal rules table into the order you desire.

Checking a Strategy
When you have written the signal rules for a strategy, or at least some of them, you may want to check that 

you have not made any mistakes. You can check certain things about your strategy, though not all, as 

described here. Even if your strategy passes the check, things could still go wrong when you try to use it in a 

simulation. This is because Trade Strategist can only check certain things when the strategy is actually used in 

a given context. 

1.  Open the Strategy Inspector window by double clicking a strategy.

2.  Click on the "Check Strategy" toolbar item, or select the Strategy > Check Strategy menu item. You 
should see a drawer with check results appear.

3.  If there are problems reported in the drawer, correct them, and re-check.

4.  Close the drawer if desired by selecting the "Toggle Check Drawer" toolbar item. You can also open it 



again with this toolbar item.

Keeping Notes
Trade Strategist allows you to keep notes for each strategy that you make. This can be useful if you forget 

what the strategy is about, or want to give the strategy to someone else. 

1.  Open the Strategy Inspector window by double clicking a strategy.

2.  Click on the "Notes" tab.

3.  Type your notes in the "Notes" editor.

Writing a Description
Trade Strategist allows you to write a short description of each strategy that you create. This description is 

displayed in the main simulation window whenever a strategy is selected. It can be used as a brief reminder of 

what a strategy is about, for yourself in the future, or for anyone that you give your strategy to. 

1.  Open the Strategy Inspector window by double clicking a strategy.

2.  Click on the "Notes" tab.

3.  Type your description in the "Description" editor. You should see it change in the simulation window as 
you type.
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Expressions

Introduction to Expressions
Trade Strategist has its own mathematical language which you use to define conditions under which buy and 

sell signals should be triggered. The syntax of this language is simple, but is different to the usual 

mathematical syntax used by your high-school teacher. The 'normal' way of writing mathematical formulas is 

actually not very consistent. For example, take the equation 

1 + sin(30) 

This expression has two numbers, and two operators. The addition operator + appears between the subjects 

upon which it acts, i.e. 1 and sin(30). This is known as an 'infix' syntax. The other operator is the sin; it acts 

on the number 30. The sin is written in front of the subject it acts on, which is known as prefix syntax. 

To make all expressions consistent, Trade Strategist only makes use of prefix syntax. This is not difficult, just a 

bit unusual at first. In Trade Strategist, instead of 1+1, you would write add(1, 1). After using this approach 

for a short time you will appreciate it, because you don't need to remember lots of complicated syntactical 

rules: all expressions are structured exactly the same. 

For the same reason, Trade Strategist does not make use of natural language expressions. Although this 

seems like a good idea, in practice it is actually more complex. You end up having to learn and remember the 

words of the language, and the order in which they must appear. This is actually more trouble than learning the 

simple prefix approach adopted in Trade Strategist. 

Expression Syntax
So what is the syntax of Trade Strategist? Here is a simple example: 

GreaterThan( Close(-1), Close(0) ) 

The basic form of an expression is: keyword( argument_1, argument_2, ... ). The keyword states 

what operator or function is being applied. Note that it is case-insensitive, so ADD, Add, and add are all 

equivalent. The arguments are numbers or other expressions that the expression is applied to or which define 

the expression. Let's look in more detail at the expression above. 

The expression above, if written in English, would state 'Is the close on day -1 greater than the close price on 

day 0?'. If this were true for a particular date, the expression would have the value true; otherwise it would 

take the value false. The expression above is actually several subexpressions combined into one. One of the 

expressions is Close(-1). The Close function takes a single argument, in this case -1, and has the value of 

the close price on the day corresponding to the index. So Close(-1) has the value of the close price on day -



1. Similarly, Close(0) is the close price on day 0. 

The two Close expressions are subexpressions of the function GreaterThan. Not surprisingly, this function 

corresponds to the mathematical operator >. It has the value true if the first argument is greater than the 

second argument. So, in this case, it will be true if Close(-1) is greater than Close(0), or the close price 

on day -1 is greater than the close price on day 0. 

That's really all there is to the syntax of expressions in Trade Strategist...simple. Note that the nesting of 

expressions can go as deep as you like. So we can change the above expression to the following: 

GreaterThan( Close( add(-2, 1) ), Close(0) ) 

This expression actually is equivalent to the original expression. The add(-2, 1) subexpression just means 

'add -2 to 1', and so has the value -1. So the two expressions are exactly equivalent. This demonstrates how 

you can nest expressions inside other expressions. 

Evaluation Types
Each expression in Trade Strategist can be evaluated. The value of the expression is limited to a few basic 

types: float, integer, and boolean. A float is a floating point number, or decimal number, such as 5.6. An integer 

is a whole number like 5, and a boolean can take the values true and false. All expressions must evaluate 

to one of these three types. 

To give an example, the GreaterThan function evaluates to a boolean, i.e., it is either true or false. 

Another example is the Add function. This is more complex because the type it evaluates to depends on what 

its subexpressions evaluate to. For example, Add( 1, 1 ) evaluates to 2, which is an integer. However, Add

( 1.1, 1) evaluates to 2.1, which is a float. 

Knowing the evaluation type of an expression is important, because there are restrictions on which types are 

allowed as parameters in any given expression. For example, you cannot add two booleans, so the add 

function can only accept integer and float subexpressions, but not boolean subexpressions. A logical operator, 

like or, on the other hand, only accepts booleans: you cannot write or( 1, 1 ) without getting an error. 

Time-Dependent Expressions
Time-dependent expressions are expressions that vary depending on the day they are evaluated. Simple 

examples include the close price (Close) and trading volume (Volume), and more complex examples are 

technical indicators like the stochastic oscillator (Stochastic). Each of these expressions have one or more 

arguments which stipulate a day or days. 

Time-independent expressions can also become time dependent if one of their subexpressions is time 



dependent. For example, the expression GreaterThan( Close(-2), Close(-1) ) is time-dependent, 

even though GreaterThan is not, since it has subexpressions which are time-dependent. 

All time-dependent functions include a relative day index. If the expression is a top level expression, which isn't 

a subexpression, like Close(-1), the day index is relative to day 0, the day on which a trade is being 

considered. So Close(-1) is simply the close price on day -1, the day before the trade is to be made. But 

what about when a time-dependent expression is a subexpression? 

Take the more complicated expression Sum( Close(-2), 5, -1). Since Sum is a top level, the day index 

argument (-1) indicates that the summation will be calculated for day -1. The 5 indicates that it is a sum over a 

range of 5 days. But what is actually being summed? The answer is Close(-2). If Close(-2) were a top-

level expression, it would be the close price on day -2, but because it is a subexpression here, the -2 is not 

taken with respect to day 0, but is taken relative to the enclosing function, Sum. 

What does all of this amount to? Well, the Sum expression above simply adds up the values of an expression 

on the days -5, -4, -3, -2, and -1. The expression being summed is Close(-2), so what we are actually 

adding up is the close price on days -7, -6, -5, -4, and -3. So the relative day index in the Close expression is 

relative to the enclosing expression Sum, not day 0. 
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Expression Library
The Expression Library is a browser that provides information about all of the expressions available in Trade 

Strategist. Expressions are arranged in the library by category. Clicking a category in the Expression Library 

window, followed by one of the expressions, displays information about that expression. 

Opening the Expression Library

1.  Select the toolbar item Library, or Help > Show Expression Library.

Expression Descriptions
Each expression is described in detail in the Expression Library. Here we describe the information that is 

provided. 

Keywords A keyword is a label that represents the expression in Trade Strategist. You can often choose 

between more than one keyword. Trade Strategist treats all of the keywords for a particular expression the 

same. 

Categories Each expression is assigned to one or more categories. Note that expressions belonging to the 

Advanced category are only accessible after purchasing a Trade Strategist license. 

Description Provides a short description of the expression. 

Parameters Parameters are the arguments that must be provided in order to evaluate the expression. A table 

is provided describing each of the parameters required, in the order in which they appear. Each parameter is 

given a number (index), and name. The 'Numeric Type' column gives the type that a subexpression must have 

if it is to appear as a parameter. The 'Time Dependence' column indicates whether the subexpressions 

corresponding to each parameter have to be constant, or are allowed to vary in time. If a parameter has to be 

restricted to a certain range of values, that is indicated in the 'Allowed Range' column. Finally, a short 

description is provided of the parameter. 

Parameter Relationships A few expressions place restrictions on the relationship between two or more 

parameters. For example, one parameter may be required to be greater than another. In such instances, the 

parameter relationships are given in a table. The first column shows the indexes of the parameters involved. 

These indexes relate to the parameter table described above. The second column describes the relationship 

which must hold in order for the expression to be evaluated. 
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Stock Lists
Stock lists are lists of stock ticker names (e.g. AAPL). A stock list can include zero, one, or more stocks. Stock 

lists allow you to group stocks together. When you simulate, you can select a single stock list, rather than lots 

of individual stocks. Simulations then get run for each stock in the list, and all results displayed together.

Adding a Stock List

1.  Open or create a new Trade Strategist document by selecting File > Open... or File > New.

2.  Click on the Add Stock List toolbar item, or select the menu item Data > Add Stock List. You should 
see an extra row appear in the Stock List Table.

3.  Enter a name for the stock list in the text field underneath.

4.  Enter the stock tickers in the list in the editor under the stock lists table. The tickers can be separated 
by space, return characters, commas, semi-colons, or colons. Any combination of these delimiters can 
also be used — you are not restricted to using only one type of delimiter in a stock list.

Editing a Stock List

1.  Select the row of the stock list you wish to edit in the stock lists table.

2.  Edit the name or list of stock tickers as desired.

Removing a Stock List

1.  To remove an existing stock list, select the stock list in the stock list table of the main window. 

2.  Either press backspace, click on the Remove Stock List toolbar item, or select the menu item Data > 
Remove Selected Stock List.

3.  To get back the removed stock list, simply undo.

Reordering Stock Lists

1.  Drag-and-drop the stock lists in the stock lists table into the order you desire. The order is not important 
in Trade Strategist, but may be beneficial for your own organisational purposes.

2.  To sort the stock lists, click on the header of the stock lists table column which you wish to use for 
sorting.
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Trading Specifications
Trading Specifications define the constraints on a simulation. Details such as the funds available initially, the 

cost of a trade, and the period of time over which the simulation is run.

Editing Trading Specifications

1.  Open an existing Trade Strategist document or create a new one.

2.  Enter trading specifications in the text fields provided in the lower-right corner of the main simulation 
window.

Initial Investment
The Initial Investment is the funds available in the simulation at the beginning of the simulation. Set this to the 

amount you expect to begin trading with in order to make the simulation more relevant. 

Maximum and Minimum Single Purchase
Sometimes you might not want to put everything in one basket. You may want the simulation to only spend 

some of the available funds in any given trade, rather than all of them. You can set a limit on the maximum 

amount that can be spent in a single trade by setting the Maximum Single Purchase. This is the maximum that 

can be spent in total (including commission) in a single trade. If you don't want to have a maximum purchase 

limit to play a role in your simulation, just set it to a very large number, much larger than any amount you could 

expect to be available in funds during the simulation. 

Similarly, you may not want to spend less than a certain amount in any given trade. This might be because you 

don't want to lose too large a percentage to the commission. By setting the Minimum Single Purchase, you can 

set a limit on the minimum amount that can be spent in a single trade. If you don't want to have a minimum 

purchase limit, just set it to zero. 

Commission
The Commission is the cost of making a trade, which goes to a stock broker. In Trade Strategist, the cost of a 

buy trade is the same as a sell trade, and no distinction is made between different types of orders like market, 

limit, and stop. All trades cost the same amount, and are not dependent on the size of the trade being made. 

There is no charge if an order is placed which is not carried out (e.g., a limit order for which the limit price is not 

reached). 

Starting Date and Finishing Date
The Starting Date is the first date in the simulation time period. The Finishing Date is the last. Both dates are 

included in the simulation. Note that either date can fall on a day for which there was no trading, in which case 

the first trading day after the Starting Date, or first trading date before the Finishing Date is used. The format of 

the dates is mm/dd/yy. 



Simulations
Once you've created at least one strategy and one stock list, and edited the trading specifications, you are 

finally ready to run a simulation. When you run a simulation, Trade Strategist retrieves the data for the stocks 

in the stock list you have selected, performs virtual trading with the strategies you have selected, and tabulates 

and charts the results for you.

Running a Simulation

1.  Open a Trade Strategist document or create a new one.

2.  Add any strategies and stock lists that you want to perform simulations for.

3.  Set the trading specifications.

4.  Select the strategies for which you would like to perform simulations in the Strategies Table. You can 
select multiple strategies by holding the SHIFT or APPLE keys while you click on the strategies.

5.  Select the stock list by clicking on the row containing the stock list in the Stock List Table.

6.  Press the Simulate toolbar item, or select the Analysis > Run Simulation menu item to run the 
simulation(s). You should see a progress bar indicating the simulation progress, and then a results 
window should appear containing results.

Stopping a Simulation

1.  If you decide you want to stop a simulation prematurely, click on the "Simulate" toolbar item, or select 
the Analysis > Stop Simulation menu item.

What days are included?
Despite what you might think, a simulation usually does not begin making trades on the first day for which 

trading data is available after the starting date stipulated in the Trading Specifications. The reason for this is 

that the expressions in a strategy cannot be properly evaluated unless a certain amount of data is available 

before the actual trading date. For example, if a strategy included a 20 day simple moving average, at least 20 

days of data is needed before the expressions in the strategy can be evaluated to determine if a trade should 

be made. That means there needs to be at least 20 spare days at the start of the simulation range. The extra 

data needed to start-up a simulation is sometimes referred to as the lookback. 

Note that this can also happen at the end of a simulation range, but usually doesn't. The reason is, strategies 

usually don't depend on data from the future (i.e. on or after day 0), so no spare days are needed. It is, 

however, possible to make unrealistic strategies, perhaps for comparative reasons, that do depend on future 

data, and these will also require spare days at the end of the simulation range. 
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Results
After running a simulation or simulations, you get the results. This section explains the results that are given.

How do simulation results get presented?
The results of a simulation or simulations are presented in tabular and chart form. Two different types of 

tabular results are presented: final results and detailed results. Final results concern the simulation as a whole, 

and detailed results are presented day-by-day for the duration of the simulation. 

Results are available for every possible combination of a strategy and a stock, but are only presented for one 

combination at a time. You use the popup buttons in the toolbar to choose the stock and strategy of the 

displayed results. 

Final results
Final results are results at the end of the simulation period. These give you a general idea of how well a 

strategy performs, and how much risk it involves, without showing any specific day-to-day details. 

First trading day of simulation The first date in the simulation for which trading data was available. Note that 

this may not be be the same as the date you entered as the starting date in the Trading Specifications, if there 

was no trading on the day you entered. Note also that it is not necessarily the first day considered for trading in 

the simulation, because most simulations need spare days (i.e. lookback) at the beginning of the simulation 

range before the strategy expressions can be properly evaluated. 

Last trading day of simulation The last date in the simulation for which trading data was available. Note that 

this may not be be the same as the date you entered as the finishing date in the Trading Specifications. It is 

usually the last day considered for trading in the simulation, but for certain "unrealistic" strategies, which use 

data from the future (i.e. data for day "0" or days thereafter), it may not be. In such cases, the simulation needs 

spare days at the end of the simulation range in order to properly evaluate the strategy expressions. 

Total final value (cash and stock) This is the total value of the portfolio at the end of the simulation. This 

includes all cash and stock. The monetary value of the stock is evaluated at the close of the last day for which 

there is data; no commission is deducted in the conversion. 

Final balance The cash available upon completion of the simulation. It does not include any stock owned at the 

end of the simulation. 

Number of shares owned The number of shares owned in the stock upon completion of the simulation. 

Number of buy trades made The total number of times that a buy trade was made during the simulation. 



Number of sell trades made The total number of times that a sell trade was made during the simulation. 

Maximum portfolio value during simulation The maximum total value of the portfolio on any day of the 

simulation. The total value includes cash and stock owned. The value of the stock is converted to cash at the 

close price, with no commission deducted. 

Minimum portfolio value during simulation The minimum total value of the portfolio on any day of the 

simulation. The total value includes cash and stock owned. The value of the stock is converted to cash at the 

close price, with no commission deducted. 

Percentage of winning trade combinations A trade combination is defined as a series of trades initiated with no 

shares owned, and ending with no shares owned. The simplest example of such a combination is buying some 

shares, and then selling them all again. The combination only ends when the number of shares owned drops 

to zero. So a combination could consist of two buys and a sell, for example. This result is the percentage of 

combinations for which the total value of the portfolio increases, i.e., a winning trade combination. 

Average percentage win for winning trade combinations This is the expected percentage increase in portfolio 

value for any winning combination averaged over the simulation. 

Standard deviation of percentage win for winning trade combinations This is the standard deviation of the 

percentage increase in portfolio value for winning combinations. It is an indication of how much the percentage 

increase varies on average from the mean winning percentage. 

Average percentage loss for losing trade combinations A losing trade combination is a trade combination that 

results in a decrease in portfolio value. This result is the expected percentage decrease in portfolio value for 

any losing combination averaged over the simulation. 

Standard deviation of percentage loss for losing trade combinations This is the standard deviation of the 

percentage decrease in portfolio value for losing combinations. It is an indication of how much the percentage 

decrease varies on average from the mean losing percentage. 

Largest single day gain in portfolio value The maximum gain in the value of the portfolio (stocks plus cash) 

during the simulation, from the close on one day to the close on the next. This is expressed as a percentage of 

the first of the two close prices. 

Largest continuous multi-day gain The maximum continuous percentage gain in the value of the portfolio 

(stocks plus cash) during the simulation. "Continuous" in this sense means that the value of the portfolio must 

increase from day close to day close, without decreasing. A "continuous gain" can occur over several days. In 

order for the gain to continue, only the close price has to increase from day to day: within a single day, the 

price may rise or fall. The gain is expressed as a percentage of the first of the close prices in the period of the 



continuous gain. 

Largest single day loss in portfolio value The maximum loss in the value of the portfolio (stocks plus cash) 

during the simulation, from the close on one day to the close on the next. This is expressed as a percentage of 

the first of the two close prices. 

Largest continuous multi-day loss The maximum continuous percentage loss in the value of the portfolio 

(stocks plus cash) during the simulation. "Continuous" in this sense means that the value of the portfolio must 

decrease from day close to day close, without increasing. A "continuous loss" can occur over several days. In 

order for the loss to continue, only the close price has to decrease from day to day: within a single day, the 

price may rise or fall. The loss is expressed as a percentage of the first of the close prices in the period of the 

continuous loss. 

Detailed results
Detailed results are day-by-day results. These give you specific details about the day-to-day performance of a 

strategy: when it signals to buy or sell, how much the portfolio value changes each day, etc. You can use these 

results to see how your strategies can be improved. 

The detailed results are presented in pairs of rows in a table. The first row shows the signal that was generated 

by the strategy before the open of trading. The row directly below the row showing the signal presents the 

results for the trading day. So, remember that the signal shown in a row applies to the trading day in the row 

directly below it. 

The results shown are as follows: 

Date The date for which the detailed results are given. 

Close The close price of the stock for the day in question. Note that this price is adjusted for dividends and 

stock splits. 

% C.P. (Percentage Change in Price) The change in the close price from the previous day, as a percentage of 

the price on the previous day. 

Total Value The total value of the portfolio (cash and shares) at the close of the day in question. Shares are 

converted to cash at the close price with no commission deducted. 

% C.T.V. (Percentage Change in Total Value) The change in total value of the portfolio from the previous day, 

as a percentage of the price on the previous day. 

C.S.O. (Change in Shares Owned) The change in the number of shares owned from the previous day. A 



positive number indictates more shares are owned on the current day than the previous day; a negative 

number indicates less shares are owned on the current day. 

S.O. (Shares Owned) The number of shares owned at the close of the day. 

Balance The cash balance at the close of the day. This does not include any share value. 

Open The open price of the stock for the day in question. Note that this price is adjusted for dividends and 

stock splits. 

High The high price of the stock for the day in question. Note that this price is adjusted for dividends and stock 

splits. 

Low The low price of the stock for the day in question. Note that this price is adjusted for dividends and stock 

splits. 

Volume The trading volume of the stock for the day in question. 

Chart results
Chart results, like detailed results, are day-by-day results. But chart results are presented graphically, and so 

are much more useful for quickly identifying when a strategy performs well, and when it doesn't. 

Total Value of Portfolio This shows the sum value of shares-owned, and cash, as a function of time. 

Buy and Sell Signals This chart indicates when buy and sell signals were generated by the strategy. Buy 

signals point upward, and are green in color. Sell signals are red, and point downwards. 

Open-High-Low-Close Price The standard bar chart for price. The day range is indicated by the vertical bar. 

The open price is indicated by a tick to the left, and the close price by a tick to the right. 

Trading Volume The trading volume shown as a histogram. Each vertical line represents the volume on a 

single trading day. 

Synchronizing Scrollbars
If you are dealing with results for several different stocks and/or strategies, you may wish to compare them 

directly. Checking the 'Synchronize Scrollbars' checkbox can help in this case: When you select a different 

stock or strategy, the newly displayed results will be scrolled to the position of last results displayed, meaning 

you don't need to manually scroll to find the relevant place in the data. The scrollbars of both the Detailed 

Results Table and Charts are synchronized when the checkbox is selected. 



Signals
If you find a strategy that works well for you in simulations, you might be tempted to use it in real-life trading. 

Make sure you have thoroughly tested the strategy before you do, and are convinced that the results you are 

getting in the simulations are accurate, and not caused by a bug in Trade Strategist, for example. Even if the 

simulation results are accurate, always bear in mind that success in the past is no guarantee for the future: just 

because a strategy works well on past data does not mean it will necessarily be successful in the future. 

If after these considerations you still wish to use Trade Strategist to guide your trading, you are ready for 

signals. Signals are generated by Trade Strategist for a set of strategies and a selection of stocks. The signals 

are based on the most recently available data. Beware that this may not be up-to-date, so always check 
carefully that the signals you see apply to the trading day which you are using them for. 

Signals are only available after purchasing Trade Strategist Pro. 

Generating Signals

1.  Open a Trade Strategist document or create a new one.

2.  Add any strategies and stock lists that you want to generate signals for.

3.  Select the strategies for which you would like to generate signals in the Strategies Table. You can 
select multiple strategies by holding the SHIFT or APPLE keys while you click on the strategies.

4.  Select the stock list by clicking on the row containing the stock list in the Stock List Table.

5.  Press the Signals toolbar item, or select the Analysis > Generate Signals. You should see the 
signals window appear. Wait for Trade Strategist to download the required data and generate the 
signals.

6.  If you decide you don't want to generate the signals anymore, you can simply close the signals window 
before Trade Strategist is finished generating them.

Which day are the signals for?
You need to be careful when considering the signals that Trade Strategist generates. For each combination of 

a strategy and a stock, Trade Strategist shows the last date (ie Last Trading Day) for which it was able to 

retrieve data. The signal generated assumes that this date is the last date for which trading occurred for the 

stock shown. The signal is for the trading day which follows the date shown. Trade Strategist doesn't display 

the date that the signal is for, because this would require it to consider weekends, public holidays, stock 

market holidays etc. You should carefully check the date shown for each signal, to be sure that the 
signal is for the trading day you expect it to be for. 
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Charts
In order to create good strategies, you need to know how the expressions you are using behave. Trade 

Strategist allows you to make charts of expressions, so that you can compare them, and see how they can 

best be utilized. You can even export the data you calculate to other applications like spreadsheets. In this 

way, Trade Strategist can be used as a powerful financial calculator. 

Opening the Chart Window
To open the chart window, either select the menu item Window > Charts, or click the Charts toolbar item. 

Adding Plots

1.  Click the round + button under the plot area.

2.  Fill in a name for the plot. This name must be different to all other plot names.

3.  Choose a color for the plot by clicking the color well.

4.  Fill in a valid Trade Strategist expression. This expression must have a floating point value.

Selecting Plots

1.  To select an existing plot, select its name from the pop up button.

2.  Examine, remove, or edit the selected plot as desired.

Removing Plots

1.  Select the plot you wish you remove by selecting its name in the pop up button.

2.  Click the round – button under the plot area.

Hiding Plots
If you have added many plots to the chart window, you may wish to hide some of them. To do this, either 

1.  Select a plot you wish you hide by selecting its name in the pop up button.

2.  Select the Hide check box.

3.  Repeat for each plot you wish to hide.

or 

1.  Click the Hide All button to hide all plots.

2.  Select any plots you wish to display, and deselect the Hide checkbox for those plots.



Displaying Plots

1.  Make sure that the plots you wish to view are not hidden.

2.  Enter a start date (mm/dd/yy) and end date for the chart.

3.  Enter the ticker of a single stock.

4.  Click the 'Plot' button, and wait. Trade Strategist may need to download data, so this could take a 
moment.

Saving Plots
Plots are automatically saved along with your strategies. Simply save your document, and your plot 

expressions will be saved so that next time you open your document, they will be unchanged. 

Exporting Chart Data
The Chart Window is not only useful for creating plots of data, it can also be used as a calculator to generate 

data for other applications such as spreadsheets. Trade Strategist has access to a very wide range of 

Technical Analysis indicators, which can be combined in infinitely many ways. In this sense, Trade Strategist is 

much more powerful than a spreadsheet, and can be used to complement the strengths of a spreadsheet 

application. 

You can copy the data generated for a plot by simply choosing Copy from the Edit menu after you have 

created some plots. The data is put on the clipboard in tab-delimited form, and can be pasted directly into other 

applications. Only the data of visible plots is put on the clipboard — data for hidden plots is not included. 

You can export data to file by selecting Data > Export Chart Data... after creating your plots. Data is exported 

to file in comma-separated values (CSV) format, which can be imported into other applications. 

Limitations
The demo and standard registered versions of Trade Strategist place a limit of five plots in the Charts Window. 

To create new plots, you either have to delete old ones, or purchase Trade Strategist Pro, which allows you to 

create and save an unlimited number of plots. 
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Data
Trade Strategist would be useless without historical data. This section explains where the data comes from, 

how it is stored in the Trade Strategist database, what types of data can be used, and how you can export data 

to other applications. 

Data Sources
You can set the data source that Trade Strategist uses in the Preferences panel. For general stock data from 

around the world, the best choice is the Yahoo! Finance data source. This site provides historical data for all 

major US and international markets, in addition to charting and analysis. The symbols you enter in your stock 

lists should correspond to the symbols given on the Yahoo! Finance web site. You can do a symbol search on 

the web site to find the symbol to use for a given company. 

The OANDA data source is for foreign exchange rates (Forex). Only close-of-trade rates are available, and 

data is only available for up to 2000 days. The symbols you need to enter, in order to access the OANDA 

currency rates, take the form CURRENCY1_CURRENCY2. This gives the exchange rate from CURRENCY1 to 

CURRENCY2. For example, to get the US dollar to Euro exchange rate, enter USD_EUR for the symbol. 

If you have access to your own source of data, there are two ways you can use it: the simplist is to choose the 

Comma-Separated Values (CSV) File data source, and then populate a folder with files containing the data in 

a given format. The second way is to use the Software Development Kit (SDK), but this requires some 

experience in programming. Both approaches are discussed further below. 

Types of data available
The Random source provides daily data, including the open, high, low, and close prices, in addition to the 

trading volume. This data is entirely fictional. 

Yahoo! provides daily equities data, including the open, high, low, and close prices, in addition to the trading 

volume. 

OANDA provides foreigen exchange (Forex) daily close-of-trade data for up to 2000 days. The symbol for an 

exchange rate is CURRENCY1_CURRENCY2. For example, US dollar to Euro is entered in Trade Strategist as 

USD_EUR. 

The Comma-Separated Values (CSV) File data source provides the open, high, low, and close prices, and the 

volume. You must provide this data to Trade Strategist as described below if you wish to use this data source. 

Data adjustments
You can choose how you want price data to be adjusted in the Preferences panel. Data can be adjusted for 

stock splits and/or dividend payments. Not all data sources allow for price adjustments. If adjustments are not 

http://finance.yahoo.com/
http://www.oanda.com/


allowed, the adjustment popup items will be disabled. 

Downloading data
As long as you have your data preferences configured correctly in the Preferences panel, data should be 

downloaded automatically as needed when Trade Strategist runs a simulation or plots a chart. Data will either 

be downloaded, or read from file, depending on the data source you have selected in the Preferences. 

You can also force Trade Strategist to retrieve data for a particular stock list. This might be useful if you want 

the data to be added to your database (see below) so that you can later test your strategies offline. To 

explicitly download data for a stock list: 

1.  Set the range of dates in the main simulation window.

2.  Select the stock list.

3.  Choose the menu item Data > Retrieve Stock List Data

You can cancel the data retrieval by selecting Data > Stop Data Retrieval. 

Supplying your own data
If you have access to your own source of data, one simple way to use it is to choose the Comma-Separated 

Values (CSV) File data source. This source takes its data from files in a folder of your choosing. You need to 

find a way to populate the folder with files containing stock data; each file contains data for one stock, and the 

file name is chosen to indicate what type of data is included, as explained further below. After you have 

entered the path to the directory in the Preferences panel, and chosen the Commas-Separated Values (CSV) 

File data source, Trade Strategist will look in the directory for data whenever it is required. 

To make use of the CSV File data source you need to adhere to some basic rules about formatting and file 

names. Trade Strategist expects file names to be of the following form:  
<STOCKTICKER>__<SPLITOPTION>__<DIVOPTION>.csv  
(Note that the format includes double underscores)  
After the stock ticker comes a split adjustment option, which can either be SPLITADJ or SPLITUNADJ, for split-

adjusted and split-unadjusted data, respectively. The dividend adjustment option follows; it can be either 

DIVADJ or DIVUNADJ, which stand for dividend-adjusted and dividend-unadjusted. For example, the name of 

a file containing split and dividend adjusted data for Apple would be AAPL__SPLITADJ__DIVADJ.csv. 

Trade Strategist also expects the data in each file to be formatted in a particular way. Each line should include: 

a date, like 21-Jul-04; the open price; the high price; the low price; the close price; and the trading volume. 

Anything appearing on the line after the volume is simply ignored. The entries on each line should be 

separated by commas, and the lines should be in order from oldest to newest data. Here is some data in the 

correct format: 



21-Jul-04,32.42,32.71,31.34,31.62,5379600
22-Jul-04,31.25,31.73,31.06,31.68,5966400
23-Jul-04,31.53,31.75,30.48,30.70,4885200
26-Jul-04,30.85,31.45,30.78,31.26,7034500
27-Jul-04,31.80,32.75,31.57,32.43,7589400
28-Jul-04,32.31,32.41,31.16,32.27,5090200

In addition to the CSV File data source, users familiar with Cocoa programming can use the Software 

Development Kit (SDK) to add their own data sources to Trade Strategist. The data source used by Trade 

Strategist can be selected in the Preferences panel. Using the SDK, any data source could be used, from a 

simple file, to a database, or commercial data provider. 

The database
Trade Strategist includes a built-in database, which can be used to store any data that gets retrieved while you 

are working. This database serves two purposes: it allows you to use Trade Strategist when you are offline, 

and it can make retrieving data considerably faster, because data that is already found in the database does 

not need to be downloaded again. 

The behavior of the database can be configured in the Preferences panel. You have a number of options 

available to you. For example, you can opt to only use the database for data, and never download new data. 

Or you can choose to always download new data, and never access the database. Other combinations are 

also possible. 

It is useful to know a little about how the database works. In particular, it is important to realize that the 

database stores data separately for each stock, data source, and combination of adjustment options. In other 

words, it is possible that the database contains several data sets for any one stock: one for each combination 

of data source and adjustments. For example, a database may contain separate data sets for Apple (AAPL) 

from Yahoo! and some other data source, and different sets for split-adjusted and split-unadjusted options. The 

particular data set used depends on the choice of data source and adjustment options that you have selected 

in the Preferences panel. A data set for one data source will never be used if another data source is selected. 

The database itself is simply a file. It is located in the folder Library/Application Support/

Trade Strategist in your home directory. The file is called PricesDatabase.tsdb. If at any point you 

want to empty the database, simply quit Trade Strategist, and throw this file in the Trash. Trade Strategist will 

create a new database when it next tries to retrieve or store data. 

Data for non-US Stocks
Trade Strategist can run simulations for any stock for which historical data is available from Yahoo! Finance 
(US). Data for many non-US stocks is provided by Yahoo, so there is a reasonable chance that the data you 

seek will be there, but if you are unsure, you should check the web site directly. 

http://finance.yahoo.com/
http://finance.yahoo.com/


Note that non-US stocks usually have an extension to the stock ticker. For example, KPN.AS is the Dutch 

company KPN, listed on the Amsterdam Stock Exchange. To find out what the stock extension is for your 

stock, go to Yahoo! Finance (US) and perform a search for the stock. 

Exporting data
You cannot directly export the data that Trade Strategist downloads, but you can use the chart window to 

calculate any function, and export or copy the chart data. You can then import or paste into a spreadsheet or 

charting program, for example. 

If you just want to export the historical data, rather than the values of a function or indicator, you can simply 

use price functions in the chart window to generate the data you want. For example, if you want the close price 

and open price, simply create two plots in the Chart Window, and enter the expressions close(0) and open

(0). Plot the data, and then either copy, or choose the Data > Export Chart Data... menu item. 
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Extending
Trade Strategist provides Cocoa developers with a way to extend its functionality. In particular, new 

expressions can be introduced, and specialized data sources. This section describes briefly how you can do 

this. 

What is an SDK?
Despite what you might think, an SDK is not an extreme terrorist organization, it is a Software Development Kit 

(SDK). With the Trade Strategist SDK you can write plugins for Trade Strategist, which get loaded and extend 

the functionality of the application. In particular, you can add new functions and indicators, and/or new data 

sources. 

Adding New Expressions
Trade Strategist includes a wide variety of different Technical Analysis functions and indicators, which can be 

combined in an almost infinite variety of ways. But sometimes there could be functions that are not included, or 

you may want much more advanced functionality, such as is provided by artificial intelligence algorithms. In 

such instances, the Trade Strategist SDK could be the answer. 

With the SDK, you can write new expression classes that are integrated into Trade Strategist as if they were 

built-in. They can be used in strategies, for charting, and are even included in the Expression Library. 

Adding New Data Sources
You can also add new data sources with the Trade Strategist SDK. Trade Strategist has a number of free data 

sources already built in, but you may want to add a different source. Perhaps you are subscribed to a particular 

data provider, and would like to access their historical data in Trade Stratgist. Or perhaps you have a database 

full of historical data that you want to use in Trade Strategist. With the SDK, solutions to these problems only 

require a little Cocoa programming experience, and a bit of time. 

How Does it Work?
The Trade Strategist SDK allows you to write plugins in Objective-C/Cocoa. Tools for developing plugins are 

provided freely by Apple, and may even already be installed or ready for installation on your hard disk. If not, 

you can download them from the Apple developer site. 

When you have the Xcode Developer Tools installed, you can use the SDK provided with your copy of Trade 

Strategist to compile a plugin with your functions and data sources. You then install this plugin in a folder, and 

Trade Strategist will load it next time it starts up. You then have access to the functions and data sources from 

your plugin from within Trade Strategist. 

Getting Started

http://developer.apple.com/


Details of how you write, compile, and install Trade Strategist plugins are provided in the documentation 

accompanying the SDK. Example code is also available, which you can compile to create plugins, and see 

how it all works. Make a copy of the SDK somewhere on your hard disk, and you are ready to get started. 

Limitations
The Trade Strategist SDK only works with the Pro version of Trade Strategist. If you are using the demo or 

standard versions, plugins will not be loaded by Trade Strategist at start up. In order to use plugins in Trade 

Strategist, you need to upgrade to a Trade Strategist Pro license. 
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Registering
There are a few different license levels available in Trade Strategist. Each entitles you to use certain features 

of Trade Strategist. This section tells why you should buy a license, and what features each license level 

allows. 

The Demo Version
When you download Trade Strategist for the first time, you get the demo version of the application. This has 

some restrictions: 

●     You can only launch the application 40 times or on 20 different days whichever comes first.

●     You can only make up to 5 charts at any time.

●     You can't use Advanced functions (see the Expression Library to see which functions are 'Advanced').

Other restrictions on the demo version are the same as for the Standard version, described below. 

The Standard Version (discontinued)
Previously there was a version of Trade Strategist known as the Standard version. The Standard version is 
no longer available for purchase. This version has access to advanced functions and unlimited charts, unlike 

the demo version. However, there are some limitations: 

●     You can't generate signals with your strategies.

●     You can't load plugins created with the Software Development Kit (SDK).

If you purchased the Standard version in the past, and decide you need the extra functionality provided by the 
Pro version, you can purchase an upgrade, which is cheaper than a full Trade Strategist Pro license. 

The Pro Version
Purchasing a Trade Strategist Pro license gives you access to the full functionality of Trade Strategist, 

including advanced functions, signal generation, unlimited charts, and loading of plugins. If you are serious 

about your trading, you will probably want a Trade Strategist Pro license. 

How do you purchase a license?
There are two ways to purchase Trade Strategist. The first involves selecting the menu item 

Trade Strategist > Purchase Trade Strategist and selecting the version you want. This will open a wizard, 

and allow you to purchase the software without ever leaving the application, provided you are connected to the 

internet. This is the easiest way to purchase the software, and you will not even have to fill in a serial number. 

The second way you can purchase Trade Strategist is to go to the Trade Strategist web site, and follow the link 

to eSellerate, where you can register online. 

http://www.trade-strategist.com/
http://www.esellerate.net/


Who carries out the transaction?
Transactions to purchase Trade Strategist are handled by eSellerate, a well-known software ecommerce 

provider. It is a reputable company, and transactions are secure. They accept all major credit cards. 

Why Purchase a Trade Strategist License?
The Mac market is not large, and fringe areas of Mac software development are often undernourished as a 

result. Technical Analysis is a niche market itself, so developers of Technical Analysis software for the Mac are 

developing for a niche inside a niche. That's a small market! 

To be able to continue developing their software, developers either have to charge a high price for it, or 

sacrifice quality. Many resort to developing cross platform software, which tends to lead to a reduction in 

quality, and thus user experience on each platform. 

Trade Strategist is a Mac-only Technical Analysis program. Our goal is to create a good user experience, as 

well as a reasonably powerful piece of Technical Analysis software. We are targeting a very small market, and 

attempting to keep the software very affordable at the same time. 

If you like Trade Strategist, you should pay the small fee we ask for it. The more users that pay the fee, the 

more time we can justify spending developing it, and the better it will become. So, if you want good, 

reasonably-priced Technical Analysis software for the Mac, please consider purchasing Trade Strategist. 

If you are not that idealistic, you should still buy a license, because licensed users get functionality not found in 

the demo version. (See above for details.) 
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More Info
Want to know more about Trade Strategist or Technical Analysis in general? This section tells you where to 

look. 

Where can I learn more about Trade Strategist?
Try the Trade Strategist web site: www.trade-strategist.com. While you're there, join the trade-strategist-users 

mailing list, and discuss your strategies and ideas for Trade Strategist with other users. 

Where can I learn more about Technical Analysis?
There are lots of web sites dedicated to Technical Analysis. Use a search engine to find your favorites. 

A good site for learning Technical Analysis is www.clearstation.com. You can use Yahoo! Finance for stock 

data and basic charting, and the Stocks and Commodities Magazine web site has some very interesting 

articles about Technical Analysis, though a small fee is charged for many of them. TADOC lists and describes 

many of the functions used in Trade Strategist, and how they can be used. 

The book Technical Analysis from A to Z by Steven B. Achelis is a good introduction and resource. It is 

browsable freely on the internet here. 
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